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Directions (Question 1 to 5): Read the passage
carefully to answer the following questions:

Once upon a time, there was an enchanted

forest that was home to many magical

.creatures. The trees in the forest were so tall |

that their tops touched the clouds, and their
leaves sparkled like emeralds. The forest
was protected by an invisible barrier that
only the pure of heart could pass through.
Many people tried to enter the forest, but
failed. Among them was a girl named Arial,
who had heard tales of the forest's wonders
from her grandmother. With a heart full of
hope and curiosity, Arial set out on a journey
to find the enchanted forest. As she
approached the barrier, Arial closed her eyes
and took a deep breath. To her delight, she
" was able to pass through the barrier

3. What motivated Aria to seek out - the
. enchanted forest?

a. She was following a map she found.
b. She wanted to escape from her village.
.C. She heard tales of the forest's wonders
from her grandmother.
d. She was looking for a rare flower

. How did Aria feel when she passed through

the barrier?
a. Delighted
c. Scared

b. Disappointed
d. Angry

. What did Aria discover inside the forest?

a. Dangerous creatures and dark caves

b. A village of humans living in secrecy.

c. Talking animals, friendly fairies, and
crystal-clear streams:

effortlessly. Inside, she encountered talking

animals, friendly fairies, and streams of

crystal-clear water.

.- What was unique about the trees in the

enchanted forest?

a. They were tall and their leaves sparkled
" like emeralds. S :

b. They were short and had golden leaves.

c. They were covered in snow year-round. 7

d. None of these

2. Who could pass through the invisible barrier
that protected the forest? ) .
a. Only children under the age of 10.

b. Only the pure heart. ‘

c. Only those who had magical powers.

d. None of these .

d. A treasure chest filled with gold.

. Choose the correct option to complete the:

sentence:

Neither of the answers correct.
a.is b. will

‘¢: had d. have been .

. He {in London since 2010.

b. has lived
d. Living

a. lived
c. has been living

8. What is. the past participle of the verb ‘to-

slide’. - ‘
a. slid b. slided
c. sliding d. Sliden

9. Which idiom means feeling sick’.

a. flying off the handle
b. burning the midnight oil
c. under the weather ‘

7 dinapickle -



10. Each of the students a project to

present.
a. have b. has
c. are d. Were

11. What is the function of the VLOOKUP

formula in Excel?

a. Organize and sort data in ascending or
descending order automatically.

b. Retrieve specific data from a row in a
table based on a matching value in the
first column.

c. Perform calculations, such as summing
values across a specified range of cells.

d. None of these

12. What is an operating system?

a. A program that allows users to write and -

execute code in high-level languages.

b. A system component that physically
conhnects hardware devices for seamless
communication. .

c. A background application designed to
monitor and protect the system from
external threats. '

d. A core system software responsible for

~managing hardware resources and
providing a platform for applications to

run.

13. What is e-governance? 4
a. A framework for electronically delivering
. government services, improving
transparency -and efficiency.

b. AAsystemvfoquse’d on maintaining digital

records for crime and law enforcement

v agencies. .
~¢. A technology-driven approach aimed at
replacing {raditional - governance’

structures with automation.
© d. None of these

14. Which feature in Microsoft Word aliows you
to create a mail merge? .
a. The tool used for managing citations and
bibliographies.
b...A  feature. designed for linking- and
integrating data between documents.
c. A dedicated tab that facilitates merging
personalized data into templates for
letters, envelopes, or labels.

d. None of these

15. How can you freeze the top row in Excel?
a. Insert > Freeze Panes > Freeze Top Row
b. Data > Freeze Panes > Freeze Top Row
c. Home > Freeze Panes > Freeze Top Row
d. View > Freeze Panes > Freeze Top Row

16. In Excel. what does the |F function do?
a. Sorts data by evaluating a condition and
applying a specific order.
b. Compares a  logical
provides customized outputs based on
whether the condition is met or not.
summary

expression and

c. - Automatically
statistics * for numerical

generates

data, such as
averages or sums.

d. None of these

17. Which of the following is defined as an
attempt to steal, spy, damage or destroy
computer systems,. networks or their

associated information?

a. Cryptography b. Computer Security

c. Cyber Attack . d. None of these

18. A small text file created by a website that is
stored in the user’'s computer te'mpbrarily for

~ that session is called

| - b. Cache

a. Bug _
d. Cookies

. ¢ Malware



19. What does KYC stand for-in the context of |-

financial cybersecurity? ..
“a. Know Your Costumer
b. Know Your Cause

c. Keep your credit- .

d. None of these

20. Which is the world’s first computer network?
a. ARPANET b. ETHERNET
c. NETSPACE d. None of these

21. Which ocean
Australia?
a. Indian Ocean
c. Atlantic Ocean

lies between Africa and

b. Pacific Ocean
d. Arctic Ocean

22. Who is known as the Father of the White
Revo!utlon of India?

b. Verghese Kurien
d. Rajendra Prasad

a. Manohar Bapat
¢. Harsh Vardhan

23. Which desert is the hottest desert in the

world?
a. Thar Desert
c. Atacama Desert’

b. Gobj Desert
d. Sahara Desert

| - 24, ‘Udbodhana’,_ a magazine,,\_/vas. founded by

which prominent figure?
a. Jyotirao Phule
b. Swami Vivekananda
" ¢..Mahatma Gandhi
d. Mautana Abul Khan Azad

25. In human beings, what is the prlmary
function of Haemoglobm?
. a. Carrymg nutrlents to the cell
b. Producing antibodies

C. Carrymg oxygen from the Iungs to the rest

] ofthe body e
~ d.Removing waste fromthe cells . -

26. Which among these is known as ‘Black

Pagoda'? .
a. Konark Sun Temple
b. Deogarh Temple

-.c. Khajuraho Temple .
d. Shore Temple

27. Which river is the longest river in India?
a. Godavri b. Yamuna
c. Narmada d. Ganga

28. Where are Ajanta Caves located?
a. Madhya Pradesh  b. Gujarat
c. Maharashtra d. None of these

29. Which dam in India produces maximum
amount of Hydroelectric power?

~a. Tehri Dam
b. Bhakra Nangal Dam
c. Hirakud Dam
d. Sardar Sarover Dam

30. What does an IPO stand for in the stock
market?
‘a. Immediate. Public Offering
b. Initial Public Offering
c. Internatlonal Purchase Offer
d. lnterna! Private Operatlon

31. Which film is selected as the Indian entry for

~'the best International Feature :Film for the
97" Academy Awards (Oscars)? -

b. Fighter

d. Kalki: 2898 AD

a. Maharaja
. C. Laapataa Ladies

32. Who is the current World Chess Champton?

a. Gukesh Dommaraju
b. Magnus Carlsen

c Dmg Llren

d. Arjun EngaIS|



33. ‘Impossible is Nothing’ is-the tagline of
which company? :
a. Puma
c. Adidas

b. Skechers

d. Nike

34. Who is the Chief Minister of Rajasthan?
a. Himanta Biswa Sarma
b. Bhupendra Patel

c. Nitish Kumar
d. Bhajan Lal Sharma

35. Who is the new chairman of Tata Trusts?
a. Jamshedji Tata b. Noel Tata
¢. Ratan Tata d. None of these

36.External Affairs Minister S. Jaishankar went
to which country for SCO meeting?
a-Sri-kanka b Brazil—
c. Pakistan d. Japan

37. Name the cyclone which struck Odisha and
West Bengal recently and caused large
scale evacuation these states?

b. Cyclone Fani

d. Cyclone Phailin

a. Cyclone Dana
‘¢. Cyclone Hudhud

38. Name of a state that is recited in our
National Anthem, which is not in independent

India?
a. Sindh b. Utkala
c. Punjab d. None of these

39. Which Indian player won the maximum .

medals in Paris Olympics?
a. Neeraj Chopra b. Ramita Jindal
c. Arjun Babuta " d. Manu Bhaker

40. Which state has currently approved a 35%
-reservation for women in a state government -
recruitment?

a. Odisha
-c..Jharkhand - -

b. Madhya Pradesh
d. Rajasthan

41. If DRIVE is coded as 59372, and SPUR is
coded as 6489, what will be code for

PRIDE?
a. 49532 b. 49253
c. 45329 d. 49352

42. In a certain code language, ‘health is
wealth' is written as ‘gol hiv lah’, ‘smile good
health’ is written as ‘tim gol gil’ and ‘cry is not
smile’ is written as ‘lah vil tan gil'. How will
‘wealth’ be written in the same code

language? : ,
a. gol b. lah
c. gil d. hiv

43.The ratio of present ages of Asha and Lata
is 5:6. If the difference between their ages is
6 years, then what will be Lata’s age after 5

years?
a. 45 b. 41
¢35 .40

44 If 18 October 2006 was Wednesday, then

what was the day of the week on 17 October

20007 :
a. Tuesday

c. Wednesday

b. Monday -
d. Friday



45. In a family of 8 persons with two couples, P

is the son.of Q and'vb.rother _of R..S is the.

daughter of M, who is married to R. T is the
aunt of S and mother of V. R’s nephew W is

the son of P and has a.sister. V. How is V.

related to M?
a. Cousin Sister
c. Daughter

b. Nephew
d. Niece

46. In the following letter series, some of the
letters are missing which are given in that
order as one of the alternatives below it.
‘Choose the correct alternative.

__aba_ _ba_ab
a. abbba b. baabb
c. abbab d. bbaba

Directions (Ques 47 to 49): Read the following

information carefully to answer the given

49. Counting from the right, to which subject
does the 39" book belong?
a. History  b. Psychology
c. Geography d. Science

50. Find the missing number in the given figure.

b. 49
d 72

a. 64
c. 100

questions:

Fifty books belonging to different subjects,
viz. History (8), Geography (7); Literature
(13), Psychology (8) and Science (14), are
placed on a shelf. They are arranged in an
alphabetical order subject to the condition

“that no two books of the same subject are |

placed together so long as books of other
subjects are available. Unless otherwuse
mentloned all counting is done from the left.

47. Which subject does the 40" book belongs
0
a. Science
c. History

.b. Psychology -
d. Literature

48 What is the posmon of the Iast book in

i Psychology’?
a. 36" b.‘37th _
c. 38" d. 39"




a0

cae oy

e




ANSWER KEY

Recruitment test conducted on 23/12/2024 for post of Cashier & Clerk-cum-Cashier

under Dr. B.R Ambedkar Institute of Medical Sciences, Mohali

1 A 26 A
2 B 27 D
3 C 28 C
4 A 29 A
5 C 30 B
6 D 31 C
7 C 32 A
8 A 33 C
9 C 34 D
10 B 35 B
11 B 36 C
12 D 37 A
13 A 38 A
14 C 39 D
15 D 40 B
16 B 41 D
17 C 42 D
18 D 43 B
19 B 44 A
20 A 45 D
21 A 46 C
22 B 47 D
23 D 48 C
24 B 49 A
25 C 50 B




BABA FARID UNIVERSITY OF HEALTH SCIENCES,FARIDKOT

E.E.G Tech l ‘

(under Dr B.R. Ambedkar State Institute of Medical Sciences, Mohali)

QUESTION BOOKLE |

IMB IMPRESSION OF THE CANDIDATE

OMR ANSWER SHEE

ROLL NO:
FULL SIGNATURE OF THE CANDIDATE

Co-ordinator stamp
FULL SIGNATURE OF INVIGILATOR

Time Allowed: 1:00 Hour (11:00 AM to 12:00 Noon) Maximum Marks: 50

1. Use BLACK FINE TIP BALL PEN only. Use of pencil is not allowed.

Write your Roll number on the OMR answer-sheet and also on the question-booklet only in the
space provided for the purpose and at no other place in the question booklets and Answer-sheet

3. Enter the Question Booklet Set and Number on the OMR Answer-sheet and also darken the
corresponding bubbles with BLACK FINE TIP BALL PEN.

4. Do not put any marks anywhere in the Question booklet /on the OMR Answer-sheet.

5. There are 50 objective type questions in all of 1 Mark each. Before attempting the questions,
check that the Question-booklet is complete. In case any question/part of question or page is
missing, inform the Centre Superintendent within 5 minutes of the start of the examination. After
that no claim will be entertained.

6. Each question is followed by four alternative responses listed as A), B), C) and D) out of
which only one is correct / most correct. In case, all the ovals are left blank, there will be
deduction of marks @ 0.25 mark for each such unattempted question. Fifth oval 'E'
(introduced for security purpose) is to be darkened in case you do not want to attempt the
question to avoid negative marking.

7. To open the question booklet, remove the seal gently when asked to do so. Handover the OMR
Answer-sheet to the officer on duty on the completion of the time before you leave the
examination hall.

8. The candidates are permitted to carry his/her question booklet after completion of the
examination but OMR Sheets are compulsory required to be deposited with the invigilator.

9. A candidate who create disturbance of any kind or changes his/her seat or is found in possession
of any paper possibility of any assistance to him/her or unfair means will be expelled from the
examination by the Centre superintendent/Observer, whose decision shall be final. (“Expulsion”
for this purpose would mean cancellation of the entire examination of the candidate).

10. THE CANDIDATES ARE NOT PERMITTED TO CARRY ANY TELECOMMUNICATIION
EQUIPMENT SUCH AS WATCH, CELLULAR PHONE, WIRELESS SET, SCANNER ETC.
INSIDE THE EXAMINATION HALL.

11. For rough work, use only the blank space of the Question booklet.

12. The candidates will not be allowed to leave the examination hall during the examination.

13. Borrowing any material is not allowed. :

14. The answer-sheet is designed for Computer evaluation. If the instructions are not followed
properly, the candidate alone shali be responsible for the resultant loss.

15. Smoking/Refreshment shall not be allowed in the Entrance Test Centre/Hall.

16. Male candidates shall affix their Left Thumb Impression (LTI) while Female candidates shall affix
Right Thumb Impression (RTI) at the prescribed place on the OMR answer sheet, Question
Booklet and attendance sheet. The Centre superintendent shall also obtain and retain it for
record.

17. The candidate must fill both the question booklet number and OMR answer sheet number on the
attendance sheet.

18. No candidate shall be allowed to leave the centre before 12:00 Noon.







1. Wave with a single deflection etther up or
down from the basehne

A. Transient

B. Polyphasic

C. Paroxysmal
D. Monophasic

2. What pattern is affected by eye-opening and
closing?

A. Alpha Rhythm

B. Posterior Dominant Rhythm
C. Beta Rhythm

D. Mu Rhythm

3. Electrographic Seizure Pattern on EEG is
called as:
A. Ictal
B. Interictal”
C. Sharp transient

8. EEG is the recording of the
A. Signal from axons of the pyramidal cells

B. Signal from the dendrites of the pyramidal

cells
C. Cyton secretions

- DrAxonsecretion T T e e

9. Which wave can help point out the place of a
brain tumor?

A. Alpha waves

B. Beta waves

C. Delta waves

D. Gamma wave

10. An EEG for seizure is characterized by
A. Low amplitude, high frequency waves
B. High amplitude, low frequency waves

* C. High amplitude, high frequency waves

D. Low amplitude, low frequency waves

_.b. The frequency of the waves acquired when

5. The frequency of Delta waves is

" D.Causeskin flaking - » :" I

D--Epileptiform

4. What unit is used to describe amplitude?
A. Kilowatts
B. Univolts
C. Hertz
D. Microvolts

A. Less than 4 Hertz
B. Greater thar)_13 Hertz _

C.4-7 Hertz
D. 8-13 Hertz

the person is in an alert and wakeful state is

A. 4-8 Hz

B. 8-13 Hz
- C. 13-30Hz
D. >30Hz

7. The electrode gel is used to

- A.Reduceskinresistance . . " o
B. Increase skin resistance - =t H

~ C. Moisturize the skin

11. What is the term used for portable EEG
A. Transport EEG '
B. Personalised EEG.
C. Ambulatory EEG
D. Travel EEG

12. The placement of the sensors on the
“cranium in order to take EEG is called

A.Montage
B. Cranial Cap
C. Electrode Placement
D. Electrode Cap
13. Indications for clinical EEG assessment of
psychiatric patients include:
A. Rule out specific neurological disorders
B. Suspicion of epilepsy
C. Pre- and post electroconvuls've therapy o
D. All of the above o

14, Frequency of sleep splndles
A.10t0-14 HZ
B.0.5 to a4 HZ—

' C.20t0 80 Hz B
D 4 to 7 Hz



Sam Lo N e

15. Electroencephalogram ({EEG) rhythm was
first recorded by:

A. William Einthovan

B. Egas Moniz

C. Hans Berger

D. Gaillard L

16. The most prominent EEG wave pattern of an
awake, relaxed adult whose eyes are closed is:
A. Delta
B. Theta
C. Alpha
D. Beta

17. EEG patternin REM sleep is:
A. High amplitude, slow waves
B. Low amplitude, rapid waves
C. High amplitude, rapid waves
D. Low amplitude, slow waves

22. A standard EEG array consists of how many
electrodes:

A. 22
_B.20
C.19
D. 21

23. Which are the 2 main types of Montages:
A. Bipolar and Referential
B. Unipolar and Referential
C. Bipolar and Differential
D. Unipolar and Differential
24. The diagrammatic
representation of

following is the
montage.

18. Certain natural processes interrupt the
normal alpha waves. This process is called as
alpha block or

A. Disruption

B. Beta introduction

C. Asynchronization

D. Desynchronization

19. Abnormal sleep spindles can indicate
A. Cerebral Palsy B. Meningitis
C. Epilepsy D. Paralysis

20. What kind of EEG can be expected in

Narcolepsy? _

A. Alpha waves with short bursts of Beta waves

B. Alpha Waves with short burst of Gamma
waves

C. Alpha Waves with short bursts of sleep
spindles

D. Continuous alpha waves

21. Full Form of EEG is

- A. Electroencephalogram

B. Electroencephalography
C. Electrocardiogram

D. Electrocardiography

A.10-20%
B.20-40%
C.40-60%
D.60—-80 %

25. Electrodes to measure EEG are placed on

B. Scalp
D. Ears

A. Forehead
C. Cheek

26. According to the international 10/20 system
to measure EEG, even number denotes which
side of the brain?

A. Left

B. Top

C. Bottom

D. Right



27. Letter F in the EEG electrode placement

system denotes?
B A. Front
B. Face
C. Frontal lobe
“'DUoFast o T

28. Normal EEG frequency range is
A. 50-500Hz
B. 0.5-50HZ
C. 0.05-5Hz
D. 1-200Hz

29. Disturbance in the EEG pattern resulting
from the external stimuli is called

A. Provoked response

B. Crocked response

C. Evoked response

D. Impulse response

35. The frequency of theta waves is
A. Less than 4 hertz

B. Greater than 13 hertz
C. 4-7 Hertz

D. 8-13 Hertz

36. What is the name of the three protective
" membranes that cover and protect the brain?

A. Cerebral Spinal Fluid
B. Meninges

C. Cortex

D. Viscera

37. If an electrode is placed on F3, where would
it be placed:

A. Frontal lobe, right side

B. Frontal lobe, left side

C. Temporal lobe, Right side
D. Temporal lobe, Left side

30. Which rhythm is the prihcipal compénent of

the EEG that indicates the alertness of the

brain? . -
A. Theta rhythm
C. Beta rhythm

B. Gamma rhythm
D. Alpha rhythm

31. The letter T in the EEG electrode placement

system denotes?
A. Temporallope
C. Trace

B. Temper lobe
D. Timpanic

32. According to the international 10/20 system
to measure EEG, odd number denotes which
side.of the brain?
A. Left
C. Top

B. Right
D. Front

33. A wave that has 2 or more components of a
different direction. .
“A. Diphasic
C. Monophasic

B.Ictal
D. Polyphasic

34, Regular waves that are similar_ to sine
. waves. ’ : - i
. A Transient B.Polyphasic
- -C.Ictal D. Sin,usoid}al

3

38. What.is the order of EEG waves in terms of
frequency from high to low.

A. Alpha,Beta,Gamma,Theta,Delta

B. Beta, theta,Delta, Alpha,Gamma

C. Gamma, Beta, Alpha,Theta,Delta

D. Theta,Beta,Gamma,Alpha,Delta

39. Which of the following is true of EEG

recordings?

A. EEGs are usually recorded while the person
walks on a treadmill.

B. EEGs require that a dye be injected into the
brain.

C. EEGs are always recorded using less than six
electrodes. ‘ : :

D. None of the other statements are true of
EEGs.

40. Which wave would represent light SIeep:
A.Theta - B.Alpha - - e
C. Beta D. Delta

41. Stage 2 sleep is defined by the presence of:

‘A. spikes-and slow waves

~ "B.sleep spindles and K complexes.
C rapidjgiye movements.

- -D. 1- to 2-Hz delta frequencies.



~42:When people are attentive to an external
stimulus or are  thinking . hard .about
something, the alpha rhythm is replaced by
A. Delta B. Theta
. G Alpha ~~ D.Beta

43. The peak to peak amplitude of the waves
that can be picked from the scalp is

a) 100Mv b) 100V
c) 100uv d) 10mv
44. Which rhythm is the principal component of
the EEG that indicates the alertness of the
brain? . :
a) theta rhythm
b) gamma rhythm
) beta rh‘ythm
)

alpha rhythm

c
d

47. Sharply. contoured waveforms that are
judged to be abnormal are called:
A. Ictal
B. Interictal
. C Epleptiform
D. Sharp transient

48. A wave that has 2 or more components of a
different direction is called:

A. Polyphasic

B. Monophasic

C. Diphasic

D. Ictal

49. High amplitude slowing can be elicited by:
A. Hyperventilation , closing of eyes
B. Arousal , Drowsiness
C. Hyperventilation, Drowsiness

45. Which of the following are physiological
artifacts on EEG:

A. Cardiac

B. Respiratory

C. Muscle related

D. All of the above

.46. What is. standard electrode . placement

system of EEG : ’ '
A. 20- 30
~C.-10-20

B. 20-25
D.30-40 -

Faov AR

D. Drowsiness, Photic Stimulation

50. Subdural and intracerebral stereotactic EEG
(SEEG) is used in :
A. Presurgical evaluation of drug resistant
focal epilepsy
B. Routine evaluation of patients with
seizures . ...
C. None of the above
D. All of the above



ANSWER KEY

Recruitment test conducted on 23/12/2024 for post of EEG Techinian under Dr. B.R
Ambedkar Institute of Medical Sciences, Mohali

1 D 26 D
2 B 27 C
3 A 28 B
4 D 29 C
5 A 30 D
6 C 31 A
7 A 32 A
8 B 33 D
9 C 34 D
10 C 35 C
11 C 36 B
12 A 37 B
13 D 38 C
14 A 39 D
15 C 40 A
16 C 41 B
17 B 42 D
18 D 43 C
19 C 44 D
20 C 45 D
21 B 46 C
22 D 47 D
23 A 48 A
24 A 49 C
25 B 50 A




